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1 Major Safety Precautions

1-1 Before You Start

Icons used in this manual

Using this Manual
• Make yourself fully aware of the safety precautions before using this product.

• If a problem occurs, refer to the 'Troubleshooting' section.

Copyright Notice
The contents of this manual are subject to change without prior notice for performance improvement.

Copyright ©2009 Samsung Electronics Co., Ltd. All Rights Reserved.

The copyright of this manual is reserved by Samsung Electronics, Co., Ltd.

The contents of this manual may not be partially or in whole reproduced, distributed or used in any form without the written 
permission of Samsung Electronics, Co., Ltd.

The SAMSUNG logo and SyncMaster are the registered trademarks of Samsung Electronics, Co., Ltd.

Microsoft, Windows and Windows NT are the registered trademarks of Microsoft Corporation.

VESA, DPM and DDC are the registered trademarks of the Video Electronics Standard Association. 

The ENERGY STAR ® logo is the registered trademark of the U.S. Environmental Protection Agency. 

All other trademarks mentioned herein belong to their respective companies.

As an ENERGY STAR ® partner, Samsung Electronics, Co., Ltd. certifies that this product satisfies the ENERGY STAR 
®specifications for energy saving.

ICON NAME MEANING

Caution Indicates cases where the function may not work or the setting may be canceled.

Note Indicates a hint or tip to operate a function.



1-2 Care and Maintenance

External Surface and Screen Maintenance

Securing the Installation Space
• Keep the required distances between the product and other objects (e.g. walls) to ensure proper ventilation.

Failing to do so may result in fire or a problem with the product due to an increase in the internal temperature.
Install the product so the required distances shown in the figure are kept.
 

The appearance may differ depending on the product.
 

About persistent images
• Displaying a still image for a long time may create a persistent image or stain on the screen. 

If you do not use the product for a long time, set the power-saving mode or screen saver.

• Due to technological constraints of the LCD Panel manufacturer, the images generated by this product may appear either 
brighter or darker than normal by appr. 1ppm (parts per million) pixel.
The number of sub-pixels of an LCD panel by size:  The number of Sub-Pixels = Max. Horizontal Resolution x Max. Vertical 
Resolution x 3
Example) If the maximum resolution is 1920 x 1080, the number of sub-pixels is 1920 x 1080 x 3 = 6,220,800.

Clean the product with a soft dry cloth.

• Avoid cleaning the product with an inflammable substance such 
as benzene or thinner or with a wet cloth. This may result in a 
problem with the product.

• Avoid scratching the screen with your fingernails or a sharp 
object.

• Avoid cleaning the product by spraying water onto it. If water 
enters the product, it may result in fire, electric shock or a 
problem with the product.

A white stain may be generated on the surface of the model if a 
supersonic humidifier is used near it.
 

The appearance and the color may differ depending on models.
 

When installing the product with a stand When installing the product with a wall-mount



1-3 Safety Precautions

Icons used for safety precautions

Meaning of Signs

Power Related
 

The following images are for your reference and may differ depending on models and countries.
 

Warning

ICON NAME MEANING

Warning
Failing to follow the precautions marked with this sign may result in a serious injury or even 
a fatality.

Caution
Failing to follow the precautions marked with this sign may result in a personal injury or 
property damage.

Do not perform. Must be followed.

Do not disassemble.
The power plug must be unplugged from the 
wall outlet.

Do not touch. Must be grounded to prevent electric shock. 

Avoid using a damaged power cord or plug 
or a loose power outlet.

• Otherwise, it may result in electric shock 
or fire.

Avoid connecting multiple electric appli-
ances to a single wall outlet.

• Otherwise, it may result in fire due to 
overheating of the wall outlet.

Avoid plugging in or unplugging the power 
supply with wet hands.

• Otherwise, it may result in electric 
shock.

Plug the power plug in firmly.

• Otherwise, it may result in fire.

Make sure to connect the power cord to a 
grounded wall outlet (for insulation class 1 
equipment only).

• Otherwise, it may result in electric shock 
or injury.

Avoid bending or twisting the power cord 
excessively and avoid placing heavy objects 
on the cord.

• Otherwise, it may result in electric shock 
or fire due to a damaged power cord.

Keep the power cord and the product away 
from a heater.

• Otherwise, it may result in electric shock 
or fire.

If the pins of the power plug or the wall out-
let are covered in dust, clean it using a dry 
cloth.

• Otherwise, it may result in fire.
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 Caution

Installation Related 

Warning

Avoid unplugging the power plug while the 
product is operating.

• Otherwise, it may damage the product 
due to electric shock.

Make sure to use only the power cord sup-
plied by our company. In addition, do not use 
the power cord of another electric appliance. 

• Otherwise, it may result in electric shock 
or fire. 

 When unplugging the power plug from the 
wall outlet, make sure to hold it by the plug 
and not by the cord. 

• Otherwise, it may result in electric shock 
or fire. 

Connect the power plug to a wall outlet that 
can be easily reached.

• When a problem occurs with the product, 
you must unplug the power plug to cut 
the power off completely. You cannot cut 
the power off completely using only the 
power button on the product. 

Avoid placing burning candles, mosquito-
repellent or cigarettes on the product. 

• Otherwise, it may result in fire.

Ask an installation engineer or relevant 
company to install the product onto the wall.

• Otherwise, it may result in injury. 

• Make sure to use the specified wall 
mount.

Avoid installing the product in a badly-venti-
lated location such as inside a bookshelf or 
closet.

• Otherwise, it may result in fire due to 
internal over-heating.

Keep a distance of at least 10 cm (3.93 
inches) from the wall when installing the 
product for ventilation.

• Otherwise, it may result in fire due to 
internal over-heating.

Keep the plastic bags used to pack the 
product away from children.

• If children place the plastic bags over 
their heads, they may suffocate.

Avoid installing the product in a location that 
is unstable or exposed to excessive vibra-
tions such as on an unstable or slanted 
shelf.

• The product may fall and this may result 
in damage to the product or injury.

• If you use the product in a location 
exposed to excessive vibration, it may 
result in a problem with the product or 
fire.

Avoid installing the product in a location 
exposed to dust, moisture (sauna), oil, 
smoke or water (rain drops) and installing it 
within a vehicle. 

• This may result in electric shock or fire.

Avoid installing the product in a location 
exposed to direct sunlight or near a heat 
source such as a fireplace or heater.

• This may shorten the product life cycle 
or cause fire.
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 Caution

Cleaning Related

Warning

Avoid installing the product where children 
may reach it.

• If a child touches the product, the 
product may fall and this may result in 
injury. 

• Since the front part is heavier, install the 
product on a flat and stable surface. 

Bend the outdoor antenna cable downwards 
at the location where it comes in the house 
so that rainwater does not flow in.

• If rainwater enters the product, it may 
result in electric shock or fire.

Install the antenna far away from any high 
voltage cables.

• If the antenna touches or falls onto a 
high voltage cable, it may result in 
electric shock or fire.

Do not let the product drop while moving it. 

• This may result in a problem with the 
product or injury. 

Do not place the product face down on the 
floor.

• This may damage the panel of the 
product.

When installing the product on a console or 
shelf, make sure that the front of the product 
does not protrude out of the console or 
shelf.

• Otherwise, this may cause the product 
to fall off and result in a malfunction or 
injury.

• Make sure to use a cabinet or shelf 
suitable to the size of the product.

When putting the product down, handle it 
gently. 

• Otherwise, it may result in a problem 
with the product or injury. 

If the product is installed in a location where 
the operating conditions vary considerably, 
a serious quality problem may occur due to 
the surrounding environment. In this case, 
install the product only after consulting one 
of our service engineers about the matter.

• Places exposed to microscopic dust, 
chemicals, too high or low temperature, 
high humidity, airports or stations where 
the product is continuously used.

Before cleaning the product, unplug the 
power cord.

• Otherwise, it may result in electric shock 
or fire.

When cleaning the product, do not spray 
water directly over the product parts. 

• Make sure that water does not enter the 
product. 

• Otherwise, it may result in fire, electric 
shock or a problem with the product. 
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 Caution

Usage Related

 Warning

Avoid spraying cleansing agent directly onto 
the product.

• This may result in discoloration or 
cracking of the exterior of the product or 
the panel coming off.

When cleaning the product, disconnect the 
power cord and clean the product with the 
supplied cleaning cloth.

• Avoid using chemicals such as wax, 
benzene, alcohol, thinner, mosquito-
repellent, fragrance, lubrication or 
cleansing agent when cleaning the 
product.
This may result in the exterior being 
deformed or the print being removed.

If you can't get the product clean with just 
the supplied cloth, use a soft, damp cloth 
with a "monitor-exclusive cleansing agent" 
and wipe the product with it. 

• If no monitor-exclusive cleansing agent 
is available, dilute a cleansing agent 
with water at a ratio of 1:10 before 
cleaning the product.

Since the exterior of the product is easily 
scratched, be sure to use the supplied 
cleansing cloth.

Since a high voltage runs through the prod-
uct, never disassemble, repair or modify the 
product yourself.

• Otherwise, it may result in fire or electric 
shock.

• If the product needs to be fixed, contact 
a service center.

To move the product, turn the power off and 
unplug the power cord, the antenna cable 
and any other wires connected to the prod-
uct.

• Otherwise, it may result in electric shock 
or fire due to the damaged power cord.

If the product generates a strange noise, a 
burning smell, or smoke, unplug the power 
plug immediately and contact a service cen-
ter.

• Otherwise, it may result in electric shock 
or fire. 

Avoid letting children hang or climb onto the 
product.

• Otherwise, it may result in the product 
falling and this may result in injury or 
death.

If you drop the product or the case is dam-
aged, turn the power off and unplug the 
power cord. 

• Otherwise, it may result in fire or electric 
shock.

Avoid placing objects such as toys and 
cookies on top of the product.

• If a child hangs over the product to grab 
an object, the object or the product may 
fall and this may result in injury or even 
death.

When thunder or lighting occurs, unplug the 
power cord and under no circumstance 
touch the antenna cable as this is danger-
ous.

• Otherwise, it may result in electric shock 
or fire.

Avoid dropping an object over the product 
or cause impact to the product.

• Otherwise, it may result in electric shock 
or fire.
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 Caution

Avoid moving the product by pulling the 
power cord or antenna cable.

• Otherwise, it may result in electric 
shock, fire or a problem with the product 
due to damage to the cable.

When a gas leak occurs, do not touch the 
product or the power plug and ventilate 
immediately.

• A spark may result in an explosion or 
fire.

• During a thunder or lighting storm, do 
not touch the power cord or antenna 
cable.

Avoid lifting up or moving the product by 
holding only the power cord or signal cable.

• Otherwise, it may result in electric 
shock, fire or a problem with the product 
due to damage to the cable.

Avoid using or placing inflammable spray or 
objects near the product.

• This may result in an explosion or fire.

Take care not to block the vent by a table 
cloth or curtain.

• Otherwise, it may result in fire due to 
internal overheating.

Avoid inserting metal objects such as a 
chopsticks, coins or hairpins, or inflamma-
ble objects into the product (the vents, 
ports, etc).

• If water or substances enter the product, 
turn the power off, unplug the power 
cord and contact a service center.

• Otherwise, it may result in a problem 
with the product, electric shock or fire.

Avoid placing a liquid container such as a 
vase, flowerpot, beverage, cosmetics or 
drugs, or a metal object over the product.

• If water or substances enter the product, 
turn the power off, unplug the power 
cord and contact a service center.

• Otherwise, it may result in a problem 
with the product, electric shock or fire.

Displaying a still image for a long time may 
create a persistent image or stain on the 
screen.

• If you do not use the product for a long 
time, use the power-saving mode or set 
the screensaver to the moving picture 
mode.

When not using the product for a long time 
such as leaving your home, unplug the 
power cord from the wall outlet.

• Otherwise, it may cause dust 
accumulation and result in fire caused 
by overheating or short circuit or result in 
an electric shock.

Set the appropriate resolution and fre-
quency for the product.

• Otherwise, it may result in eye strain.

Avoid turning the product upside down or 
move the product holding only the stand.

• This may cause the product to fall, 
resulting in damage to the product or 
injury.

Watching the product from too close a dis-
tance continuously may damage your eye-
sight.

Avoid using a humidifier or cooker near the 
product.

• Otherwise, it may result in electric shock 
or fire.

It is important to give your eyes some rest (5 
minutes every hour) when viewing the prod-
uct screen for long periods of time.

•  This will alleviate any eye strain.

Since the display panel is hot after using it 
for a long time, do not touch the product.
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Maintaining the Correct Posture when Using this Product

Keep the small accessories in a location out 
of the reach of children.

Take care when adjusting the angle of the 
product or the height of the stand.

• If your hand or finger is caught, you may 
be injured.

• If the product is tilted excessively, the 
product may fall and this may result in 
injury.

Avoid placing a heavy object over the prod-
uct.

• Otherwise, it may result in a problem 
with the product or injury.

When using headphones or earphones, do 
not turn the volume too high.

• Having the sound too loud may damage 
your hearing.

Be careful that children do not place the bat-
teries in their mouths when removed from 
the remote control. Place the battery in a 
location that children or infants cannot 
reach.

• If children have had the battery in their 
mouths, consult your doctor 
immediately.

When replacing the batteries, insert them 
with right polarity (+, -).

• Otherwise, the battery may become 
damaged or it may cause fire, personal 
injury or damage due to leakage of the 
internal liquid.

Use only specified standard batteries. Do 
not use new and used batteries together.

• This may cause a battery to break or 
leak and may cause fire, injury, or 
contamination (damage). 

The batteries (and rechargeable batteries) 
are not ordinary refuse and must be 
returned for recycling purposes. The cus-
tomer is responsible for returning the used 
or rechargeable batteries for recycling.

• The customer can return used or 
rechargeable batteries to a nearby 
public recycling center or to a store 
selling the same type of the battery or 
rechargeable battery. 

Maintain the correct posture when using this product.

• Straighten your back.

• Keep a distance of 45~50 cm (15~19 inches) from your eyes to the screen. Look down at 
the screen and face the screen forwards.

• Maintain the correct posture when using this product. 

• Adjust the angle of the product so that light is not reflected onto the screen.

• Keep your elbow at a right angle and keep your arm level with the back of your hand.

• Keep your elbow at a right angle.

• Place your heels flat on the ground while keeping your knees at an angle of 90 degrees or 
higher and maintain the position of your arm so that your arm is below your heart.
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2 Installing the Product

2-1 Package Contents

 

• Unpack the product and check if all of the following contents have been included.

• Store the packaging box in case you need to move the product at a later stage.
 

 

The cleaning cloth is supplied with black high-glossy models only.
 

CONTENTS

Installation Manual Product Warranty

(Not available in all locations)

User Manual Power Cord

Cable Holder Batteries (AAA X 2) 

(Not available in all locations)

Stand Connector Stand Base

Remote Control Cleaning Cloth

SOLD SEPARATELY

D-Sub Cable HDMI Cable Stereo Cable
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2-2 Installing the Stand

 

Before assembling the product, place the product down on a flat and stable surface so that the screen is facing downwards.
 

Insert the Stand Connector into the Stand Base in the direction shown by the 
figure.               

Check if the Stand Connector is firmly connected.

Turn the connecting screw at the bottom of the Stand base fully so that it is completely 
fixed.

Place a soft cloth over the table to protect the product and place the product onto the 
cloth face down.
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Hold the main body of the product with your hand as shown by the figure.

Push the assembled stand into the main body in the direction of the arrow as shown in 
the figure.

- Caution

Do not lift the product holding only the stand
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2-3 Removing the Stand

 

Before removing the stand, place the product down on a flat and stable surface so that the screen faces downwards.
 

Place a soft cloth over the table to protect the product and place the product face down.

Hold the main body of the product with your hand as shown by the figure. 

Pull the stand in the direction of the arrow as shown in the figure to separate it.

Turn the connecting screw at the bottom of the Stand base to separate it from the Stand 
connector.

Take the Stand Connector out of the Stand base by pulling it in the direction of the arrow 
as shown in the figure.
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2-4 Attaching a Wall Mount/Desktop Stand

Attaching a Wall Mount/Desktop Stand(not supplied)
P2370HD : This product complies with 75 mm x 75 mm (2.95 x 2.95 inches) VESA specifications.

P2570HD : This product complies with 100 mm x 100 mm (3.94 x 3.94 inches) VESA specifications. 

P2770HD : This product complies with 100 mm x 100 mm (3.94 x 3.94 inches) VESA specifications. 

1. Turn the product off and unplug the power cord from the wall outlet.

2. Place a soft cloth or cushion on a flat surface to protect the panel and place the product face down.

3. Align wall mount/desktop stand to the Monitor/TV and firmly fix the wall mount/desktop stand by fastening the screw.

4. Align the groove of the part of the product that is to be connected to the stand with the groove in the stand (desk-top stand, 
wall mount stand or another stand) and firmly fix the stand by fastening the screw.

 

• If you use screws that are longer than the standard specifications, the inside of the product may be damaged.

• For wall mounts that are not compatible with the standard VESA specifications, the length of the screw may differ 
depending on the corresponding specifications.

• Avoid using screws that are incompatible with the standard VESA specifications and avoid assembling them using 
excessive force.
This may result in damage to the product or injury due to the product falling. Samsung shall not be held liable for any 
damage or injury.

• Samsung shall not be held liable for any damage to the product or injury caused by using a wall mount/desktop stand 
that is not compatible with the specifications or due to an installation not performed by an authorized installation 
engineer.

• When installing the product using a wall mount, purchase a wall mount that provides at least 10 cm (3.93 inches) of 
space from the wall.

• Use the wall mount according to the international specifications.
 

A. Wall/Desktop Stand Mount

B. Wall mount kit/desktop stand (not supplied)
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2-5 Connecting to a Computer

1. Connect the product to a PC depending on the video output supported by the PC.
 

The connecting part may differ depending on the product model.
 

When the graphics card provides a D-Sub (analog) output

• Connect the [PC IN] port of the product to the [D-Sub] port of the PC with the D-Sub cable. 

When the graphics card provides a DVI (digital) output
2-5 Installing the Product



• Connect the [DVI-D IN] port of the product to the [DVI] port of the PC with the DVI cable.

2. Connect the [HDMI/PC/DVI-D AUDIO IN] port on the rear side of the monitor to the sound card of the PC.

3. Connect one end of the power cord to the [ POWER ] port of the product and connect the other end of the power cord to the 
110V or 220V wall outlet.

(The input voltage is switched automatically.)
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• You may enjoy clear and quality sound from the computer sound card using the monitor's speakers. (You don't need to 
install separate speakers for your computer.)

• You may get a blank screen depending on the type of video card you are using if you connect the D-sub and DVI cables 
simultaneously to one computer.

• If you connect your monitor properly using the DVI connector but get a blank or fuzzy screen, check to see if the monitor 
status is set to analog. Press [  ] button to have the monitor double-check the input signal source.
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2-6 Using it as a TV

You may view television programs on the monitor if it is connected to an antenna or cable/satellite system without installing any 
separate TV reception hardware or software on your computer.

1. Connect the cable/satellite or TV antenna cable to the [ANT IN] port on the rear side of the monitor.

• When using an indoor antenna/cable/satellite terminal:
Check the antenna terminal on the wall and then connect the antenna/cable/satellite TV cable.

• When using an outdoor antenna:
When using an outdoor antenna, we strongly suggest using a qualified technician to install it.

2. When the connections are completed, connect the TV power.

3. When the product is turned on for the first time after it was purchased, the initial setup operations (<Plug & Play>) begin. 
 

• Be careful that the coaxial cable is not bent when connecting it to the antenna input terminal [ANT IN].
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2-7 Connecting an HDMI cable

Connect the HDMI OUT port of the AV device (Blu-Ray/DVD/Cable/Satellite box) to the [HDMI IN] terminal of the monitor using 
the HDMI cable. 

Press the [SOURCE] button at the front of the monitor or on the remote control to select <HDMI> mode.
 

You do not need to make a separate audio connection when connecting via HDMI.
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2-8 Connecting Using a DVI to HDMI Cable 

1. Connect the DVI output terminal of an external device to the [HDMI IN] terminal of the monitor using a DVI to HDMI cable. 

2. Connect the red and white plugs of an RCA to stereo (for PC) cable to the same colored audio output terminals of the digital 
output device, and connect the opposite plug to the [HDMI/PC/DVI-D AUDIO IN] terminal of the product.

Press the [SOURCE] button at the front of the monitor or on the remote control to select <HDMI> mode.
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2-9 Connecting a Component cable 

1. Connect the VIDEO OUT port of the AV device (DVD/VCR/Cable/Satellite box) to the [COMPONENT IN [PR, PB, Y]] input ports 
using a component video cable [PR, PB,Y].

2. Connect the audio port of the AV device (DVD/VCR/Cable/Satellite box) to the [COMPONENT IN [[R-AUDIO-L]] port of the 
monitor.

Press the [SOURCE] button at the front of the monitor or on the remote control to select the <Component> mode.
 

For an explanation of Component video, consult your DVD/VCR/Cable/Satellite box manual.
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2-10 Connecting AV Devices

1. Connect the port of the AV device (DVD/VCR/Cable/Satellite box/Camcorder) to the [AV IN [ R-AUDIO-L ] port of the product.

2. Connect the video output terminal of the AV device and the [AV IN [VIDEO]] of the monitor using a video cable.

3. Select [AV]using the <SOURCE> button on the remote.
 

• The audio-video cables shown here are usually included with a Camcorder. (If not, check your local electronics store.)
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2-11 Connecting to an Amplifier

Connect the [DIGITAL AUDIO OUT (OPTICAL)] terminal of your monitor to the optical input of your amplifier using an optical 
cable.
 

• If no sound is emitted from the monitor, you need to use an amplifier.

• For information on how to connect a speaker and amplifier, refer to the respective user manuals provided by their 
manufacturers.
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2-12 Connecting Headphones

 Connect your headphones to the Headphone connection terminal.
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2-13 Kensington Lock 

A Kensington Lock is an anti-theft device that enables users to lock the product so that they can safely use it in public locations. 
Since the shape and usage of the locking device may differ depending on the model and the manufacturer, for more information, 
refer to the User Manual supplied with the locking device. You have to purchase the locking device separately.

Locking the product

1. Insert the locking part of the locking device into the hole of the Kensington lock of the product (  ) and turn it in the locking 

direction ( ).

2. Connect the Kensington lock cable.

3. Tie the Kensington lock cable to a desk or heavy object.
 

You can purchase the locking device from an electronics store or an online shop.
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3 Using the Product

3-1 Plug & Play Feature

When the TV is initially powered on, basic settings proceed automatically and subsequently.

1. Press the [POWER ] button on the remote control.
 

• You can also use the [ ] button on the TV.
The message <Select Language of the OSD.> is displayed.

 

2. Press the [ ] button. Select the appropriate language by pressing the ▲ or ▼ button. Press the [ ] button to confirm your 
choice.

3. Press the ◄ or ► button to select <Store Demo> or <Home Use>, then the [ ] button.
 

• We recommend setting the TV to <Home Use> mode for the best picture in your home environment.

• <Store Demo> mode is only intended for use in retail environments. If the unit is accidentally set to <Store Demo> 
mode and you want to return to <Home Use> (Standard): Press the volume button on the TV. When the volume 
OSD is displayed, press and hold the [ MENU ] button on the TV for 5 seconds.

 

4. Press the ▲ or ▼ button to memorize the channels of the selected connection. Press the [ ] button to select <Start>.
 

• <Air>: <Air> antenna signal. / <Cable>: <Cable> antenna signal. / <Auto>: <Air> and <Cable> antenna signals.

• In Cable mode, you can select the correct signal source among <STD>, <HRC>, and <IRC> by pressing the ▲, ▼, 
◄ or ► button, then press the [ ] button. If you have Digital cable, select the cable system signal source for both 
Analog and Digital. Contact your local cable company to identify the type of cable system that exists in your 
particular area.

 

5. Press the [ ] button to select <Start>. The TV will begin memorizing all of the available channels.
 

• To stop the search before it has finished, press the [ ] button with <Stop> selected.

• After all the available channels are stored. The Auto program menu then reappears. Press the [ ] button when 
channel memorization is complete. The message <Set the Clock Mode.> is displayed.

 

6. Press the [ ] button.

Press the ▲ or ▼ button to select <Auto>, then press the [ ] button. If you select <Manual>,<Set current date and time> is 
displayed.

7. Press the ▲ or ▼ button to select <Off>, <On> or <Auto>, then press the [ ] button.

8. Press the ▲ or ▼button to highlight the time zone for your local area. Press the [ ] button. If you have received a digital 
signal, the time will be set automatically. 

9. An HD Connection guide will appear. After reading, press the [ ] button.
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10. The message <Enjoy your TV.> is displayed. When you have finished, press the [ ] button.

If you want to reset this feature...

1. Press the [MENU] button to display the menu. Press the ▲ or ▼ button to select <Setup>, then press the [ ] button.

2. Press the [ ] button again to select <Plug & Play>.
 

The <Plug & Play> feature is only available in the TV mode.
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3-2 Viewing the Control panel

 

Touch one of the operating buttons lightly.

The LED buttons appear.
 

ICON DESCRIPTION

[ ] Use this button to select a function. 

Signals other than the TV signal can only be selected if the corresponding device is 
connected. 

The order in which the TV/external input signal changes.

<PC>→<TV>→<DVI>→<AV>→<Component>→<HDMI> 

[MENU] Press this button to view the On Screen Display (OSD).

This button is also used to exit the OSD or to return to a higher-level OSD menu.

[ -/+ ] Moves from one menu item to another horizontally or adjusts selected menu values.

Adjusts the audio volume. 

[ / ] Use these buttons to navigate the menu or to adjust a value in the OSD.

Press to change channels in TV mode.

[ ]
Press this button to turn the product on or off. 

Power LED

This LED is turned on when the product works normally. 
 

For information about the power saving function, refer to the power saving 
function section of the product specifications. When not using the product for a 
long time, unplugging the power cord is recommended to minimize power 
consumption.

 

Speaker -
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3-3 Remote Control

 

The performance of the remote control may be affected by a TV or other electronic device operating near the product, 
causing a malfunction due to interference with the frequency.

 

 POWER

Turns the product On/Off.

TV

Selects the TV mode directly.

Number Buttons

Press to change the channel.

PRE-CH

This button is used to return to 
the previous channel viewed.

 : Press to select additional chan-
nels (digital) being broadcast by the 
same station. For example, to select 
channel ‘54-3’, press ‘54’, then 
press ‘ ’ and ‘3’.

 MUTE

Press to temporarily cut off the 
sound.

+ VOL -

Press to increase or decrease the 
volume.

 CH 

Press to change channels.

CH LIST 

It displays "Channel List" on the 
screen.

 SOURCE

Press the button to change the 
input signal SOURCE.

Changing the SOURCE is only 
allowed for external devices that 
are connected to the monitor at 
the time.

 MENU

Opens the on-screen menu and 
exits from the menu or closes the 
adjustment menu.

FAV.CH

Press to switch to your favorite 
channels.

TOOLS

Use to quickly select frequently 
used functions.

 RETURN

Returns to the previous menu.

UP▲/DOWN▼/LEFT◄/RIGHT►/
ENTER  : Use to select on-
screen menu items and change 
menu values.

 EXIT

Exits from the menu screen.

 INFO

Current picture information is dis-
played on the upper left corner of 
the screen.

CC

Controls the caption decoder.

COLOR BUTTONS 

Press to add or delete channels and 
to store channels to the favorite 
channel list in the ”Channel List” 
menu.

MTS

Press to choose stereo, mono or 
Separate Audio Program (SAP 
broadcast).

P.SIZE

Picture size selection.
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Installing Batteries in the Remote Control
1. Lift the cover at the back of the remote control upward as shown in the figure.

2. Install two AAA size batteries.
 

Make sure to match the +and - ends of the batteries with the diagram inside the compartment.
 

3. Close the cover.
 

Remove the batteries and store them in a cool, dry place if you won't be using the remote control for a long time.

If the remote control doesn't work, check the following :

• Is the TV power on?

• Are the plus and minus ends of the batteries reversed?

• Are the batteries drained?

• Is there a power outage or is the power cord unplugged?

• Is there a special fluorescent light or neon sign nearby?
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3-4 Using the Screen Adjustment Menu (OSD: On Screen Display)

The Screen Adjustment Menu (OSD: On Screen Display) Structure

Available Modes

The icons below represent the input signals that are displayed when selecting an item in the <Source List>.

TOP MENUS SUB MENUS

Picture

[PC / DVI]

MagicBright Contrast Brightness Sharpness Auto Adjustment 

Screen Picture Options Picture Reset

Picture

[TV / AV / Component / 
HDMI]

Mode Backlight Contrast  Brightness Sharpness

Color Tint (G/R) Advanced Set-
tings

 Picture Options Picture Reset

Sound Mode Equalizer SRS TruSur-
round HD

Preferred Lan-
guage

Multi-Track 
Sound

Auto Volume Speaker Select Sound Reset

Channel Antenna Auto Program Clear Scram-
bled Channel

Channel List Fine Tune

Setup Plug & Play Language Time Game Mode V-Chip

Caption Light Effect Light Level Melody Energy Saving

Input Source List Edit Name

Application Anynet+ (HDMI-
CEC)

Support Self Diagnosis Software 
Upgrade

HD Connection 
Guide

Contact Sam-
sung

 Indicates the signal when <PC> or <DVI> is selected in the <Source List >.

This is the PC video signal that is connected to and input through the [PC] or [DVI] terminals.

Indicates the signal when <AV> is selected in the <Source List >.

This is the video signal input through the [VIDEO] terminal.

Indicates the signal when <HDMI> is selected in the <Source List >.

This is the signal input through the [HDMI] terminal.

Indicates the signal when <TV> is selected in the <Source List >.

This is the signal input through the [ANT IN] terminal.

Indicates the signal when <Component> is selected in the <Source List >.

This is the signal input through the [COMPONENT] terminal.
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Picture [PC / DVI ]

 

The default setting may be different depending on the selected Input Mode (input signal source selected in External Input 
List) and the selected resolution

 

MENU DESCRIPTION

MagicBright <MagicBright> is a feature providing an optimum viewing environment depending on the contents of 
the image you are watching. Currently five different modes are available: <Entertain>, <Internet>, 
<Text>, <Dynamic Contrast> and <Custom>. Each mode has its own pre-configured brightness 
value. 

• <Entertain>
 High Brightness
 For watching motion pictures such as a Blu-Ray or DVD.

• <Internet>
 For working with a mixture of images such as texts and graphics.

• <Text>
For documents or work involving heavy text.

• <Dynamic Contrast>
<Dynamic Contrast> automatically detects the distribution of the visual signal and adjusts to 
create an optimum contrast.

• <Custom>
Although the values are carefully chosen by our engineers, the pre-configured values may not be 
comfortable to your eyes depending on your taste.
If this is the case, adjust the <Brightness> and <Contrast> by using the OSD menu.

 Press the [TOOLS] button to display the Tools menu. You can also set the <MagicBright> by 
selecting <Tools>→<MagicBright>.

Contrast / Brightness / 
Sharpness 

You can use the on-screen menus to change the contrast and brightness according to personal pref-
erence.

• <Contrast> - Adjusts the contrast level of the picture.

• <Brightness> - Adjusts the brightness level of the picture.

• <Sharpness> - Adjusts the edge definition of the picture.

Auto Adjustment The values of <Fine>, <Coarse> and <PC Position> are adjusted automatically.

By changing the resolution in the control panel, auto function is performed.
 

Available in <PC> Mode Only
 

 Press the [TOOLS] button to display the Tools menu. You can also set the <Auto Adjustment >by 
selecting <Tools>→<Auto Adjustment>.
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Picture [ TV / AV / Component / HDMI ] 

Screen • <Coarse>
Removes noise such as vertical stripes.
<Coarse> adjustment may move the screen image area. You may relocate it to the center using 
the horizontal control menu

• <Fine>
Removes noise such as horizontal stripes.
If the noise persists even after <Fine> tuning, repeat it after adjusting the frequency (<Coarse>.)

• <PC Position>
Adjusts the screen location horizontally and vertically.

• <Image Reset>
Image parameters are replaced with the factory default values.

 

Available in <PC> Mode Only
 

Picture Options • <Color Tone>
The tone of the color can be changed.
 

Available in <PC> / <DVI> mode only
 

• <Cool> - <Normal> - <Warm> - <Custom>

• <R-Gain > - < G-Gain > - <B-Gain >
Adjusts the individual R, G, B (Red, Green, Blue) color controls.

• <Size>
 You can switch the Size.

• <16:9> - <4:3>

Picture Reset Picture parameters are replaced with the factory default values.

• <Reset Picture Mode> - <Cancel>

MENU DESCRIPTION
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MENU DESCRIPTION

Mode The Monitor has three automatic picture settings (<Dynamic>, <Standard>, and <Movie>) that are 
preset at the factory.

You can activate either <Dynamic>, <Standard>, or <Movie>.

• <Dynamic>
Selects the picture for high-definition in a bright room.

• <Standard>
Selects the picture for optimum display in a normal environment.

• <Movie>
Selects the picture for viewing movies in a dark room.

 Press the [TOOLS] button to display the Tools menu. You can also set the <Picture Mode> by 
selecting <Tools>→<Picture Mode>.

Backlight / Contrast / 
Brightness / Sharp-
ness / Color / Tint (G/
R)

Your television has several setting options that allow you to control the picture quality. 

• <Backlight > - Adjusts the brightness of LCD back light.

• <Contrast> - Adjusts the contrast level of the picture.

• <Brightness> - Adjusts the brightness level of the picture.

• <Sharpness> - Adjusts the edge definition of the picture.

• <Color> - Adjusts color saturation of the picture.

• <Tint (G/R)> - Adjusts the color tint of the picture.

Advanced Settings Samsung‘s new TVs allow you to make even more precise picture settings than previous models. 
See below to adjust detailed picture settings.
 

<Advanced Settings> is available in <Standard> or <Movie> mode.
 

• <Black Tone> - You can select the level on the screen to adjust the screen depth.

• <Off> - <Dark> - <Darker> - <Darkest>

• <Dynamic Contrast>  -You can adjust the screen contrast so that the optimal contrast is provided.

• <Off> - <Low> - <Medium> - <High>

• <Gamma> - You can adjust the Primary Color (Red, Green, Blue) Intensity.

• <Color Space> -  <Color Space> is a color matrix composed of red, green and blue colors. Select 
your favorite <Color Space> to experience the most natural color. 

• <Auto> - <Native>

• <White Balance> - You can adjust the color temperature for more natural picture colors.

• <R-Offset> - <G-Offset> - <B-Offset> - <R-Gain> - <G-Gain> - <B-Gain> - <Reset>

• <Flesh Tone> - You can emphasize the pink <Flesh Tone> in the picture.
 

Changing the adjustment value will refresh the adjusted screen.
 

• <Edge Enhancement> -   You can emphasize object boundaries in the picture.

• <Off> - <On>
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Picture Options • <Color Tone>
The tone of the color can be changed.

• <Cool> - <Normal> - <Warm1> - <Warm2>
 

• <Warm1> or <Warm2> is only activated when the picture mode is <Movie>.

• Settings can be adjusted and stored for each external device you have connected to an 
input of the TV.

 

• <Size>
 You can switch the Size.
The direct button on the remote control is [P.SIZE] button. 

• <16:9> - Sets the picture to 16:9 wide mode. 

• <Zoom1> - Magnifies the size of the picture on the screen. 

• <Zoom2> - Magnifies the size of the picture more than <Zoom1>. 

• <Wide Fit> - Enlarges the aspect ratio of the picture to fit the entire screen. 

• <4:3> - Sets the picture to 4:3 normal mode. 

• <Screen Fit> - Use the function to see the original image with no cut-off with HDMI (720p/ 1080i 
/ 1080p), Component (1080i / 1080p) or DTV (1080i) input signals. 

 

• After selecting <Zoom1>, <Zoom2> or <Wide Fit>: Press the ▲or▼ button to select 
<Position>, then press the [ ] button. Press the ▲or▼ button to move the picture up 
and down.

• Reset : Press the ▲or▼ button to select Reset , then press the [ ] button. You can 
initialize the setting.

• Settings can be adjusted and stored for each external device you have connected to an 
input of the TV.

• <TV>, <Component> (480i,480p) 
- <16:9>, <Zoom1>, <Zoom2>, <4:3>

• <DTV> (1080i), <Component> (1080i, 1080p) ,<HDMI>(720p,1080i,1080p)
 - <16:9>, <Wide Fit>, <4:3>, <Screen Fit>

 

• <Digital NR>
Digital Noise Reduction. 
If the broadcast signal received by your TV is weak, you can activate the Digital Noise Reduction 
feature to help reduce any static and ghosting that may appear on the screen.

• <Off> - <Low> - <Medium> - <High> - <Auto>

• <HDMI Black Level>
You can directly select the black level on the screen to adjust the screen depth.
 

This function is active only when the external device is connected via <HDMI>.The <HDMI 
Black Level> function may not be compatible with all external devices.

 

• <Normal> - <Low> 

• <Film Mode>
The <Film Mode> feature offers you a theater-quality viewing experience. 
 

<Film Mode> is supported in <TV>, <Component> (480i / 1080i) and <HDMI>(480i / 1080i)
 

• <Off> - <Auto> 

Picture Reset Picture parameters are replaced with the factory default values.

• <Reset Picture Mode> - <Cancel>

MENU DESCRIPTION
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Sound

MENU DESCRIPTION

Mode • <Standard>
 Choose Standard for the standard factory settings.

• <Music>
 Choose Music when watching music videos or concerts.

• <Movie>
 Choose Movie when viewing movies.

• <Clear Voice >
 Emphasizes voice over other sounds.

• <Custom >
 Choose Custom if you want to adjust the settings according to personal preference .

 Press the [TOOLS] button to display the Tools menu. You can also set the <Sound Mode> by 
selecting <Tools>→<Sound Mode>.

Equalizer You can adjust the left and right sound balance and equalizer settings as required.

• <Mode> - You can select a sound mode to suit your personal preferences. 

• <Balance> - You can adjust the left and right sound balance and equalizer settings as required. 

• <100Hz> - <300Hz> - <1KHz> - <3KHz> - <10KHz> - <Reset> 

SRS TruSurround HD <SRS TruSurround HD> is a patented SRS technology that solves the problem of playing 5.1 multi-
channel content over two speakers.

TruSurround delivers a compelling, virtual surround sound experience through any two-speaker play-
back system, including internal television speakers. It is fully compatible with all multichannel formats.

• <Off> - <On>

Preferred Language Digital-TV broadcasts are capable of simultaneous transmission of many audio tracks (for example, 
simultaneous translations of the program into foreign languages).

• <English> - <Spanish> - <French>
 

• You can listen in a language other than the Preferred Language by pressing the MTS button 
on the remote control.

• Preferred Language is available only in Digital TV mode.

• You can only select the language from among the actual languages being broadcast.
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Channel

Multi-Track Sound • <Mono>
 Choose for channels that are broadcasting in mono or if you are having difficulty receiving a stereo 
signal.

• <Stereo>
 Choose for channels that are broadcasting in stereo.

• <SAP>
 Choose to listen to the Separate Audio Program, which is usually a foreign-language translation.

 

Available in Analog <TV> Mode Only
 

Auto Volume Reduces the differences in volume level among channels.

• <Off> - <On>

Speaker Select When you watch TV with it connecting to a Home theater, turn the TV speakers off so you can listen 
to sound from the Home theater’s (external) speakers.

• <External Speaker> 
Used to listen to the sound of the External (Home Theater) Speakers.

• <TV Speaker>
Used to listen to the sound of the TV Speakers.

 

• If you select <External Speaker> in the <Speaker Select> menu, the sound settings will be 
limited.

• The volume and [MUTE] buttons do not operate when the <Speaker Select> is set to 
<External Speaker>. Please set the volume on your Home theater.

 

Sound Reset You can restore the Sound settings to the factory defaults.

• <Reset All> - <Reset Sound Mode> - <Cancel>
 

<Reset Sound Mode>: Current sound values return to default settings. 
 

MENU DESCRIPTION
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MENU DESCRIPTION

Antenna You can select antenna or cable TV.

If [ANT IN] connected, select the antenna input you want. If the antenna input is not selected prop-
erly, noise may appear on the screen.

• <Air> - <Cable>

Auto Program The TV automatically cycles through all of the available channels and stores them in memory.

In rare cases, <Auto program> may miss a few channels due to weak signals and the channels may 
not be added to the channel memory.

• <Air> - <Cable> - <Auto>

Clear Scrambled 
Channel 

The Clear Scrambled Channel function is used to filter out scrambled channels after "Auto Program" 
is completed. It removes the scrambled channels from the list by tuning the digital cable channels. 
This process may take up to 20~30 minutes.
 

This function is only available in <Cable> mode.
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Channel List Using this menu, you can add / delete or set favorite channels and use the program guide for digital 
broadcasts.

You can select these options by simply pressing the [CH LIST] button on the remote control.

• <All Channels> - Shows all currently available channels.

• <Added Channels> - Shows all added channels.

• <Favorite> - Shows all favorite channels.

 Press the [TOOLS] button to display the <Tools> menu. You can also set the add to (or delete 
from) Favorites by selecting <Tools>→<Add to Favorite> (or <Delete from Favorite>).
 

To select the favorite channels you have set up, press the [FAV.CH] button on the remote 
control

 

• <Programmed> - Shows all current reserved programs.
 

• Select a channel in the <All Channels>, <Added Channels> or <Favorite> screen by 
pressing the ▲ / ▼ buttons, and pressing the [ ] button. Then you can watch the 
selected channel.

• Using the Color buttons with the Channel List

• <Green> : Enlarges or shrinks a channel number.

• <Yellow> : Selects multiple channel lists. You can perform the add / delete or add to 
Favorite / delete from Favorite function for multiple channels at the same time. Select 
the required channels and press the yellow button to set all the selected channels at 

the same time. The  mark appears to the left of the selected channels.

• <TOOLS> : Displays the <Add> (or <Delete>), <Add to Favorite> (or <Delete from 
Favorite>), <Timer Viewing>, <Channel Name Edit>, <Select All> (or <Deselect All>) 
and <Auto Program> menus (The Options menus may differ depending on the 
situation.)

• Channel Status Display Icons

• : A channel set as a Favorite.

• : A channel selected by pressing the yellow button.

• : A Program currently being broadcast.

• : A reserved program.
 

Fine Tune Use fine tuning to manually adjust a particular channel for optimal reception.
 

• If you do not store the fine-tuned channel in memory, adjustments are not saved.

• Fine tuned channels that have been saved are marked with an asterisk <*> on the right-
hand side of the channel number in the channel banner.

• To reset the fine tuning setting, press the ▼ button to select Reset, then press the [ ] 
button.

 

 

Only Analog TV channels can be fine tuned.
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Setup

MENU DESCRIPTION

Plug & Play This brings up the menu items that appeared when you first plugged in the TV.

Language You can set the menu language.

The language chosen affects only the language of the OSD. 

Time • <Clock>
Setting the clock is necessary in order to use the various timer features of the TV.
 

• The current time will appear every time you press the [INFO] button.

• If you disconnect the power cord, you have to set the clock again.
 

• <Clock Mode>
 You can set up the current time manually or automatically.

• <Auto> - <Manual>
 

• Depending on the broadcast station and signal, the auto time may not be set 
correctly. If this occurs, set the time manually.

• The Antenna or cable must be connected in order to set the time automatically.
 

• <Clock Set>
You can set the current time manually.
 

• This function is only available when <Clock Mode> is set to <Manual>.

• You can set the month, day, year, hour and minute directly by pressing the number 
buttons on the remote control.

 

• <Time Zone>
 Select your time zone.
 

This function is only available when <Clock Mode> is set to <Auto>.
 

• <DST> (Daylight Saving Time)
 Switches the Daylight Saving Time function on or off.

• <Off> - <On> - <Auto>
 

This function is only available when <Clock Mode> is set to <Auto>.
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Time • <Sleep Timer>
The sleep timer automatically shuts off the TV after a preset time .

• <Off> - <30 min.> - <60 min.> - <90 min.> - <120 min.> - <150 min.> - <180 min.>

 Press the [TOOLS] button to display the Tools menu. You can also set the sleep timer by 
selecting <Tools>→<Sleep Timer>.
 

To cancel the <Sleep Timer> function, select <Off>.
 

• <Timer1> / <Timer2> / <Timer3>
Three different on / off timer settings can be made. You must set the clock first.

• <On Time>
Set the <hour>, <minute>, <am/pm>, and <activate/inactivate>.
(To activate the timer with the setting ve chosen, set to Activate.)

• <Off Time>
Set the <hour>, <minute>, <am/pm>, and <activate/inactivate>.
(To activate the timer with the setting you’ve chosen, set to Activate.)

• <Volume>
Set the desired volume level.

• <Antenna>
View antenna type. (<Air> or <Cable>).
 

You can set the Antenna by selecting <Channel>→<Antenna>.
 

• <Channel>
Select the desired channel.

• <Repeat>
Select <Once>, <Everyday>, <Mon~Fri>, <Mon~Sat>, <Sat~Sun> or <Manual>.
 

• When <Manual> is selected, press the ► button to select the desired day of the 

week. Press the  [ ] button over the desired day and the ( ) mark will appear.

• You can set the <hour>, <minute> and channel by pressing the number buttons on 
the remote control.

• Auto Power Off
When you set the timer On, the television will eventually turn off if no controls are 
operated for 3 hours after the TV was turned on by the timer. This function is only 
available in timer On mode and prevents overheating, which may occur if a TV is on 
for too long time.

 

Game Mode When connecting to a game console such as PlayStation™ or Xbox™, you can enjoy a more realistic 
gaming experience by selecting game menu.

• <Off> - <On>
 

• Restrictions on game mode (Caution)

• To disconnect the game console and connect another external device, set <Game 
Mode> to <Off> in the setup menu.If you display the TV menu in <Game mode>, the 
screen shakes slightly.

• If <Game Mode> is <On> :

• Picture mode is automatically changed to <Standard> and cannot be changed.

• Sound mode is automatically changed to <Custom> and cannot be changed. Adjust the 
sound using the equalizer.

• <Game Mode> is not available in regular <TV> and <PC> mode.

• If the picture is poor when external device is connected to TV, check if <Game Mode> is 
<On>. Set <Game Mode> to <Off> and connect external devices.
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V-Chip (U.S.A only) The <V-Chip> feature automatically locks out programs that are deemed inappropriate for children. 

The user must enter a PIN (personal ID number) before any of the <V-Chip> restrictions are set up or 
changed.
 

• <V-Chip> function is not available in <HDMI>, <Component> or <PC> mode.

• The default PIN number of a new TV set is 0-0-0-0

• If you forget the PIN, press the remote-control buttons in the following sequence, which 
resets the pin to 0-0-0-0 : [POWER](off)→[MUTE]→8→2→4→[POWER] (on).

• <Allow all>: Press to unlock all TV ratings.

• <Block all>: Press to lock all TV ratings.
 

• <V-Chip Lock> - You can block rated TV Programs.

• <Off> - <On>

• <TV Parental Guidelines> - You can block TV programs depending on their rating. This function 
allows you to control what your children are watching.

• <MPAA Rating> - You can block movies depending on their <MPAA rating>. The Motion Picture 
Association of America(MPAA) has implemented a rating system that provides parents or 
guardians with information on which films are appropriate for children.

• <Canadian English>

• <Canadian French>

• <Downloadable U.S. Rating> - Parental restriction information can be used while watching DTV 
channels

• <Change PIN> - The <Change PIN> screen will appear. Choose any 4 digits for your PIN and 
enter them.
As soon as the 4 digits are entered, the <Confirm New PIN> screen appears. Re enter the same 
4 digits. When the Confirm screen disappears, your PIN has been memorized.

How to Reset the TV after the V-Chip Blocks a Channel (“Emergency Escape”)

- If the TV is tuned to a restricted channel, the V-Chip will block it. The screen will go blank and the 
following message will appear:

<This channel is blocked by a Parental Lock.> <Please enter the PIN to unblock.>

Enter your PIN, then press the button [ ] button and press the ▲or▼ button to temporarily disable 
the V-Chip Lock.
 

If you forget the PIN, press the remote-control buttons in the following sequence, which resets 
the pin to 0-0-0-0 : [POWER](off)→[MUTE]→8→2→4→[POWER] (on).

 

MENU DESCRIPTION
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Caption(On-Screen 
Text Messages)

• <Caption>
You can switch the caption function on or off. If captions are not available, they will not be 
displayed on the screen.

• <Off> - <On>
 

• Press the [CC] turn the Caption on or off.

• The <Caption> feature doesn’t work in <Component>, <HDMI> or <PC> modes.
 

• <Caption Mode>
You can select the desired caption mode.
 

• The availability of captions depends on the program being broadcast.

• <Default> -<CC1>~<CC4> -<Text1>~<Text4> (analog channels only)
The Analog Caption function operates in either analog TV channel mode or when a 
signal is supplied from an external device to TV. (Depending on the broadcasting 
signal, the Analog Caption function may operate on digital channels.)

• <Default> - <CC1~CC4> - <Text1~Text4> - <Service1~Service6> (digital channels 
only)
The Digital Captions function operates on digital channels.

• <Service1~6> in digital caption mode may not be available depending on the broadcast.
 

• <Digital Caption Options> (digital channels only)

• <Size> - <Font Style> - <Foreground Color> - <Background Color> - <Foreground Opacity> - 
<Background Opacity> - <Return to Default> 

 

• The <Digital Caption Options> are only enabled when the <Caption Mode> is <Service 1 
~ Service 6>. 
(If <Caption Mode> is the default, the <Digital Caption Options> are enabled depending 
on the broadcast.)

• The availability of captions depends on the program being broadcast.

• <Default> means to follow the standard set by the broadcaster.

• Foreground and Background cannot be set to have the same color.

• <Foreground Opacity> and <Background Opacity> cannot be both set to Transparent.
 

Light Effect You can turn the LED on/off on the front of monitor. You can turn it off to save power.

• <Off> : Activates the <Light Effect> (LED) only when a button is pressed.

• <On> : Activates the <Light Effect> (LED) only while watching the TV.

Light Level Use to adjust the light level i.e., the brightness of the light.

• <1> ~ <10>
 

The higher the number, the brighter the light of the LED emits.
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Input

Melody A melody sound can be set to come on when the monitor is powered On or Off. 

• <Off> - <Low> - <Medium> - <High>
 

The <Melody> does not play

• When no sound is output from the TV because the [MUTE] button has been pressed.

• When no sound is output from the TV because the volume has been reduced to minimum 
with the volume [-] button

• When the TV is turned off by <Sleep Timer> function
 

Energy Saving This feature adjusts the brightness of the TV in order to reduce power consumption. When watching 
TV at night, set the <Energy Saving> mode option to <High> to reduce eye fatigue as well as power 
consumption. 

• <Off> : Turns off the energy saving function.

• <Low> : Sets the TV to low energy saving mode.

• <Medium> : Sets the TV to medium energy saving mode.

• <High> : Sets the TV to high energy saving mode.

• <Auto> : Automatically adjusts the brightness of the TV screen in accordance with the scenes. 

MENU DESCRIPTION

Source List  Use to select <PC>, <TV> or an external input source connected to the Monitor.Use to select the 
screen of your choice.

You can use the [SOURCE] button on the remote control.

• <PC> - <TV> - <DVI> - <AV> - <Component> - <HDMI>

Edit Name  Name the input device connected to the input jacks to make your input source selection easier.

<VCR> - <DVD> - <Cable STB> - <Satellite STB> - <PVR STB> - <AV Receiver> - < Game> -<Cam-
corder> - <PC> - <DVI PC> - <DVI> - <TV> - <IPTV> - <Blu-Ray> - <HD DVD> - <DMA>

MENU DESCRIPTION
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Application

Connecting Anynet+ Devices

1. Connect the [HDMI IN] jack on the TV and the HDMI OUT jack of the corresponding <Anynet+> device using an HDMI 
cable.

2. Connect the [HDMI IN] jack of the home theatre and the HDMI OUT jack of the corresponding <Anynet+> device using an 
HDMI cable. 
 

Connect the Optical cable between the [DIGITAL AUDIO OUT (OPTICAL)] jack on your TV and the Digital Audio Input 
on the Home Theatre. 

When following the connection above, the Optical jack only outputs 2 channel audio. You will only hear sound from the 
Home Theatre‘s Front Left and Right speakers and the subwoofer. If you want to hear 5.1 channel audio, connect the 
[DIGITAL AUDIO OUT (OPTICAL)] jack on the DVD / Satellite Box (ie Anynet Device 1 or 2) directly to the Amplifier or 
Home Theatre, not the TV.

Connect only one Home Theatre.

<Anynet+> works when the AV device supporting <Anynet+> is in the Standby or On status.

<Anynet+> supports up to 10 AV devices in total. Note that you can connect up to 3 devices of the same type.
 

MENU DESCRIPTION

Anynet+ (HDMI-CEC) What is <Anynet+>?

<Anynet+> is a function that enables you to control all connected Samsung devices that support 
<Anynet+> with your Samsung TV‘s remote. The <Anynet+ > system can be used only with Samsung 
devices that have the <Anynet+> feature. To be sure your Samsung device has this feature, check if 
there is an <Anynet+> logo on it.
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Setting Up Anynet+

 Press the [TOOLS] button to display the Tools menu. You can also display the <Anynet+> menu by selecting 
<Tools>→<Anynet+ (HDMI-CEC)>

Setup

Device List

1. Press the [TOOLS] button. Press the  [ ] button to select <Anynet+ (HDMI-CEC)>.

2. Press the  or  button to select <Device List>, then press the  [ ] button.

 - <Anynet+> devices connected to the TV are listed.

MENU DESCRIPTION

Anynet+ (HDMI-CEC) To use the <Anynet+> Function, <Anynet+ (HDMI-CEC)> must be set to On. 
 

When the <Anynet+ (HDMI-CEC) >function is disabled, all the< Anynet+> related operations 
are deactivated. 

 

Auto Turn Off Setting an <Anynet+> Device to turn Off automatically when the TV is turned off.
 

The active source on the TV remote must be set to TV to use the <Anynet+> function. 

If you set Auto Turn Off to Yes, connected external devices are also turned off when the TV is 
turned off. If an external device is still recording, it may or may not turn off. 
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 - If you cannot find a device you want, press the red button to scan for devices.

3. Press the  or  button to select a particular device and press the  [ ] button. It is switched to the selected device. 

 - <Anynet+ (HDMI-CEC)> must be set to On in the <Application> menu for the <Device List> menu to appear.
 

Switching to the selected devices may take up to 2 minutes. You cannot cancel the operation during the switching 
operation. 

The time required to scan for devices is determined by the number of connected devices. 

When the device scan is complete, the number of devices found are not displayed. 

Although the TV automatically searches the device list when the TV is turned on via the power button, devices 
connected to the TV may not always be automatically displayed in the device list. Press the red button to search for the 
connected device. 

If you have selected external input mode by pressing the [SOURCE] button, you cannot use the <Anynet+> function. 
Make sure to switch to an <Anynet+> device by using the <Device List>. 

 

Support
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MENU DESCRIPTION

Self Diagnosis  • <Picture Test>
If you think you have a picture problem, perform the picture test. Check the color pattern on the 
screen to see if the problem still exists. 

• <Yes> : If the test pattern does not appear or there is noise in the test pattern, select <Yes>. 
There may be a problem with the TV. Contact Samsung‘s call center for assistance.

• <No> : If the test pattern is properly displayed, select <No>. There may be a problem with your 
external equipment. Please check your connections. If the problem still persists, refer to the 
external device‘s user manual.

• <Sound Test>
If you think you have a sound problem, please perform the sound test. You can check the sound by 
playing a built-in melody sound through the TV. 

• <Yes> : If during the sound test you can hear sound only from one speaker or not at all, select 
<Yes>. There may be a problem with the TV. Contact Samsung’s call center for assistance.

• <No> : If you can hear sound from the speakers, select <No>. There may be a problem with 
your external equipment. Please check your connections. If the problem still persists, refer to 
the external device’s user manual.

 

• If you hear no sound from the TV‘s speakers, before performing the sound test, make 
sure <Speaker Select > is set to <TV speaker> in the <Sound> menu. 

• The melody will be heard during the test even if <Speaker Select> is set to <External 
Speaker> or the sound is muted by pressing the [MUTE] button. 

 

Self Diagnosis  • <Signal Information (digital channels only)>
Unlike analog channels, which can vary in reception quality from snowy to clear, digital (HDTV) 
channels have either perfect reception quality or you will not receive them at all. So, unlike analog 
channels, you cannot fine tune a digital channel. You can, however, adjust your antenna to 
improve the reception of available digital channels. 
 

If the signal strength meter indicates that the signal is weak, physically adjust your antenna to 
increase the signal strength. Continue to adjust the antenna until you find the best position 
with the strongest signal. 

 

Software Upgrade Samsung may offer upgrades for TV’s firmware in the future. Please visit Samsung.com or contact 
the Samsung call center at 1-800-SAMSUNG (726-7864) to receive information about downloading 
upgrades and using a USB drive. Upgrades will be possible by connecting a USB drive to the [SER-
VICE] port located on your TV.
 

• Insert a USB drive containing the firmware upgrade into the [SERVICE] port on the side of 
the TV.

• Please be careful to not disconnect the power or remove the USB drive while upgrades are 
being applied. The TV will turn off and turn on automatically after completing the firmware 
upgrade. Please check the firmware version after the upgrades are complete. When 
software is upgraded, video and audio settings you have made will return to their default 
(factory) settings. We recommend you write down your settings so that you can easily reset 
them after the upgrade.

 

HD Connection Guide This menu presents the connection method that provides the optimal quality for the HDTV. Refer to 
this information when connecting external devices to the TV.

Contact Samsung View this information when your TV does not work properly or when you want to upgrade the soft-
ware. You can view the information regarding the call center, product and software file download 
method.
Using the Product 3-4



3-5 Installing the Device Driver

 

If you install the device driver, you can set up the appropriate resolution and frequency for the product. The device driver is 
included on the CD supplied with the product. If the supplied drive file is corrupted, please visit the Samsung Electronics 
website (www.samsung.com), and download the driver.

 

1. Insert the driver installation CD into the CD-ROM drive.

2. Click on Windows Driver.

3. Select the model of your product from the model list.

4. Complete the remaining installation steps according to the instructions displayed on the screen.

5. Check if the appropriate resolution and screen refresh rate are displayed in the Control Panel settings. For more information, 
refer to the document about the Windows operating system.
3-5 Using the Product



3-6 Standard Signal Mode Table

 

An LCD monitor has one optimal resolution for the best visual quality depending on the screen size due to the inherent 
characteristics of the panel, unlike a CDT monitor.

Therefore, the visual quality will be degraded if the optimal resolution is not set for the panel size. It is recommended setting 
the resolution to the optimal resolution of the product.

 

If the signal from the PC is one of the following standard signal modes, the screen is set automatically. However, if the signal from 
the PC is not one of the following signal modes, a blank screen may be displayed or only the Power LED may be turned on. 
Therefore, configure it as follows referring to the User Manual of the graphics card.
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Horizontal Frequency

The time taken to scan one line from the left-most position to the right-most position on the screen is called the horizontal cycle 
and the reciprocal of the horizontal cycle is called the horizontal frequency. The horizontal frequency is represented in kHz.

Vertical Frequency

A panel must display the same picture on the screen tens of times every second so that humans can see the picture. This 
frequency is called the vertical frequency. The vertical frequency is represented in Hz.

RESOLUTION
HORIZONTAL 
FREQUENCY 

(KHZ)

VERTICAL 
FREQUENCY  

(HZ)

CLOCK 
FREQUENCY 

(MHZ)
POLARITY (H/V)

IBM, 640 x 350 31.469 70.086 25.175 +/-

IBM, 640 x 480 31.469 59.940 25.175 -/-

IBM, 720 x 400 31.469 70.087 28.322 -/+

MAC, 640 x 480 35.000 66.667 30.240 -/-

MAC, 832 x 624 49.726 74.551 57.284 -/-

MAC, 1152 x 870 68.681 75.062 100.000 -/-

VESA, 640 x 480 37.861 72.809 31.500 -/-

VESA, 640 x 480 37.500 75.000 31.500 -/-

VESA, 800 x 600 35.156 56.250 36.000 +/+

VESA, 800 x 600 37.879 60.317 40.000 +/+

VESA, 800 x 600 48.077 72.188 50.000 +/+

VESA, 800 x 600 46.875 75.000 49.500 +/+

VESA, 1024 x 768 48.363 60.004 65.000 -/-

VESA, 1024 x 768 56.476 70.069 75.000 -/-

VESA, 1024 x 768 60.023 75.029 78.750 +/+

VESA, 1152 x 864 67.500 75.000 108.000 +/+

VESA, 1280 X 800 49.702 59.810 83.500 -/+

VESA, 1280 X 960 60.000 60.000 108.000 +/+

VESA, 1280 X 1024 63.981 60.020 108.000 +/+

VESA, 1280 X 1024 79.976 75.025 135.000 +/+

VESA, 1440 x 900 55.935 59.887 106.500 -/+

VESA, 1600 x 1200 75.000 60.000 162.000 +/+

VESA, 1680 x 1050 65.290 59.954 146.250 -/+

VESA, 1920 x 1080 (RB) 

(P2770HD)

66.587 59.934 138.500 +/-

VESA,1920 x 1080

(P2370HD, P2570HD)

67.500 60.000 148.500 +/+
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4 Installing the Software

4-1 Natural Color

What is Natural Color ?

This software is for Samsung products only and enables you to adjust the displayed colors on the product so they more closely 
match the colors of printed pictures. For more information, refer to the online help of the software (F1).

 

Natural Color is provided online. You can download it from the website below and install;

http://www.samsung.com/us/consumer/learningresources/monitor/naturalcolorexpert/pop_download.html
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4-2 MultiScreen

What is MultiScreen ?

MultiScreen enables you to partition multiple sections on the Monitor.

Installing the Software
1. Insert the installation CD into the CD-ROM drive. 

2. Select the MultiScreen setup program.
 

If the pop-up screen for the software installation does not appear on the main screen, find and double-click the 
MultiScreen setup file on the CD-ROM.

 

3. When the Installation Wizard appears, click [Next].

4. Complete the remaining software installation steps according to the instructions displayed on the screen.
 

• The software may not work properly if you do not restart the computer after the installation.

• The MultiScreen icon may not appear depending on the computer system and the product specifications.

• If the shortcut icon does not appear, press the F5 key.
 

MultiScreen Installation Requirements
The MultiScreen installation may be affected by the graphics card, motherboard and the networking environment. 

Operating System

OS
• Windows 2000

• Windows XP Home Edition

• Windows XP Professional

• Windows Vista
 

For MultiScreen, Windows 2000 or later operating systems are recommended. 
 

Hardware
• At least 32MB of memory 

• At least 60MB of free space on the hard disk drive 

Removing the Software 
Click [Start], select [Settings]/[Control Panel], and then double-click [Add or Remove Programs]. 

Select MultiScreen from the program list and click the [Add/Delete] button. 
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5 Troubleshooting

5-1 Monitor Self-Diagnosis

 

• You can check if the product is working properly using the Self-Diagnosis function.

• If a blank screen is displayed and the Power LED blinks even if the product and the PC are properly connected, perform 
the self-diagnosis function according to the procedures below.

 

1. Turn the product and the PC off.

2. Remove the D-Sub cable from the product. 

3. Turn the product on. 

4. If the product is working properly, the <Check Signal Cable> message appears.
In this case, if a blank screen is displayed again, make sure that there is no problem with the PC and the connection.
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5-2 Before Requesting Service

 

Please check the following before requesting After-Sales service. If the problem continues, please contact your nearest 
Samsung Electronics Service Center.

 

PROBLEMS RELATED TO INSTALLATION (PC MODE)

The monitor screen flickers. Check if the signal cable between the computer and the monitor is securely 
connected and tightened.

(Refer to Connecting to a Computer) 

PROBLEMS RELATED TO SCREEN

Screen is blank and power indicator is off. Ensure that the power cord is firmly connected and the LCD monitor is on.

(Refer to Connecting to a Computer) 

 <Check Signal Cable> message Ensure that the signal cable is firmly connected to the PC or video sources.

(Refer to Connecting to a Computer) 

<Not Optimum Mode> message Check the maximum resolution and the frequency of the video adapter.

Compare these values with the data in the Preset Timing Modes Chart. 

Picture rolls vertically. Check if the signal cable is securely connected.Connect it again securely. 

(Refer to Connecting to a Computer) 

Image is not clear. Picture is blurred. Run Frequency <Coarse > and < Fine> tuning.

Turn on again after removing all accessories(video extension cable, etc.)

Set resolution and frequency to the recommended ranges.

Picture image is unstable and vibrates. Check if the resolution and frequency set for the computer video card falls 
in the range supported by the monitor. If not, reset them referring to the 
current <Information> under the monitor menu and Standard Signal Mode 
Table.

Ghost images are shown in the picture.

The image is too light or too dark Adjust the <Brightness> and <Contrast>

(Refer to the <Brightness>, <Contrast>) 

Screen is blank and the power indicator light 
blinks every 0.5 or 1 seconds

The monitor is using its power management system

Press a key on the keyboard

The screen is blank and is blinking. If you see the <TEST GOOD>message on the screen when you press the 
[ MENU] button, check the cable connection between the monitor and the 
computer to ensure that the connector is properly connected.

PROBLEMS RELATED TO AUDIO

No sound Ensure that the audio cable is firmly connected to both the audio-in port on 
your monitor and the audio-out port on your sound card.

(Refer to Connecting to a Computer) 

Check the volume level.

The sound level is too low. Check the volume level.

If the volume is still too low after turning the control to its maximum, check 
the volume control on the computer sound card or software program.

PROBLEMS RELATED TO REMOTE CONTROL 

The remote control buttons do not respond. Check the battery polarities (+/-).

Check if the batteries have been exhausted.

Check if the power is on.

Check if the power cord is securely connected.

Check if a special fluorescent or neon lamp is on in the vicinity
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NOTE ON THE PRODUCT APPEARANCE

You may see small particles if you look closely at 
the edge of the bezel surrounding the screen.

This is part of the product's design and is not a defect.
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5-3 FAQ

FAQ PLEASE TRY THE FOLLOWING!

How can I change the frequency of the video sig-
nal?

You have to change the frequency of the graphics card.

(For more information, refer to the User Manual of the computer or the 
graphics card.) 

How can I change the resolution? Windows XP: Change the resolution by selecting Control Panel →Appear-
ance and Themes→Display→Settings.

Windows ME/2000 : Change the resolution by selecting Control Panel 
→Appearance and Themes→Display→Settings.

(For more information, refer to the User Manual of the computer or the 
graphics card.)

How can I use the power saving function? Windows XP: Configure it by selecting Control Panel→Appearance and 
Themes→Display→Screen Saver Setting or configure it in the BIOS 
SETUP of the computer.

Windows ME/2000 : Configure it by selecting Control Panel→Appearance 
and Themes→Display→Screen Saver Setting or configure it in the BIOS 
SETUP of the computer.

For more information, refer to the Windows user manual for the computer.

How can I clean the outer case/LCD Panel? Disconnect the power cord and then clean the monitor with a soft, dry or 
slightly damp cloth.

Do not leave any detergent or scratches on the case.

Do not let any water enter the monitor.

What is the difference between HDTV and 
SDTV?

There are various types of digital TVs.

The most widely known types of digital TV are HDTV and SDTV. They are 
classified according to the screen quality and the video specifications.

• HDTV (High Definition TV):High screen quality.

• SDTV (Standard Definition TV):Common standard digital TV.

An SDTV has an aspect ratio of 4:3 which is the same as that of an analog 
TV. HDTV has an aspect ratio of 16:9 which is similar to a cinema screen. 
This provides a much better screen quality than SDTV.

Digital TV broadcasting in our country is ultimately orientated towards 
HDTV. (At present, all digital TVs from Samsung Electronics have the 16:9 
wide aspect ratio.)

Can I watch HD broadcasting with all digital 
TVs?

You can receive all digital broadcasts, whether they are SD or HD, using

any digital TV. However, you cannot enjoy HD programs, which are the

highest quality digital TV programs, using an SD digital TV.

(At present, all digital TVs from Samsung Electronics have the 16:9 wide

aspect ratio.)

Can I watch digital TV broadcasting with an ana-
log TV?

No.

The analog TV cannot interpret digital signals. Therefore, a digital TV is 
required to watch digital TV broadcasting.

Can I use my present antenna to receive digital 
broadcasting?

As for existing analog TV, digital TV is designed so that digital broadcast-
ing signals are received via both indoor and outdoor antennas.

If signal reception is very good in your environment, you can watch digital 
broadcasts with your existing indoor antenna. If not, it is better to install an 
outdoor antenna.
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6 More Information

6-1 Specifications

MODEL NAME P2370HD P2570HD P2770HD

LCD Panel Screen Size 23 inches (58 cm) 24.6 inches (62 cm) 27 inches (68 cm)

Display Area 509.76 mm (H) X 286.74 
mm (V) ( 20.06 inches X 
11.29 inches)

543.46 mm (H) X 305.69 
mm (V) ( 21.40 inches X 
12.04 inches)

597.89 mm (H) X 336.31 
mm (V) ( 23.5 inches X 13.2 
inches)

Pixel Pitch 0.2655 mm (H) X 0.2655 
mm (V) (0.01 inches X 0.01 
inches)

0.283 mm (H) X 0.283 mm 
(V) (0.01 inches X 0.01 
inches)

0.3114 mm (H) X 0.3114 
mm (V) (0.01 inches X 0.01 
inches)

Synchroniza-
tion

Horizontal 30~81 kHz

Vertical 56~75 Hz

Color 16.7M

Resolution Optimal Reso-
lution

1920x1080 @ 60 Hz 1920x1080 @ 60 Hz (RB)

Maximum Res-
olution

1920x1080 @ 60 Hz 1920x1080 @ 60 Hz (RB)

Input Signal, Terminated

RGB analog, DVI (Digital 
Visual Interface) compati-
ble digital RGB

0.7 Vp-p ± 5 %

Separate Type H/V Sync, 
Composite

TTL Level (V high ≥ 2.0 V, V 
low ≤ 0.8 V)

RGB analog, DVI (Digital 
Visual Interface)

0.7 Vp-p ± 5 %

Separate Type H/V Sync, 
Composite

TTL Level (V high ≥ 2.0 V, V 
low ≤ 0.8 V) 

RGB analog, DVI (Digital 
Visual Interface) 

0.7 Vp-p ± 5 % 

Separate Type H/V Sync, 
Composite 

TTL Level (V high ≥ 2.0 V, V 
low ≤ 0.8 V) 

Maximum Pixel Clock 162.000MHz (Analog,Digital)

Power Voltage AC 100 - 240 V~ (+/- 10 %), 50/60 Hz ± 3 Hz

Dimension (Width x Height x 
Depth) / Weight

571 x 364.6 x 65.5 mm 
(22.5 x 14.4 x 2.6 inches) 
(Without Stand)

571 x 432.5 x 189.5 mm 
(22.5 x 17 x 7.5 inches) 
(With Stand) / 5.8 kg (12.8 
Ibs)

605 x 384 x 66 mm (23.8 x 
15.1 x 2.6 inches) (Without 
Stand) / 6.3 kg (13.9 Ibs)

605 x 453 x 240 mm (23.8 x 
17.8 x 9.4 inches) (With 
Stand) / 7 kg (15.4 Ibs)

667 x 422 x 66 mm ( 26.3 x 
16.6 x 2.6 inches) (Without 
Stand) / 7.4 kg ( 16.3 Ibs)

667 x 484 x 244 mm (26.3 x 
19.1 x 9.6 inches) (With 
Stand) / 8.2 kg ( 18.1 Ibs)

VESA Mounting Interface 75 mm x 75 mm

(2.95 x 2.95 inches) 

100 mm x 100 mm

(3.94 x 3.94 inches)

100 mm x 100 mm

(3.94 x 3.94 inches)

Environmental 
considerations

Operating Temperature : 50°F ~ 104°F (10°C ~ 40°C)

Humidity : 10 % ~ 80 %, non-condensing

Storage Temperature : -4°F ~ 113°F (-20°C ~ 45°C)

Humidity : 5 % ~ 95 %, non-condensing

Tilt -2° ~ 22°
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Class B (Information Communication Equipment for Home Use) 

This device has been registered regarding EMI for home use (Class B). It may be used in all areas. (Class B equipment 
emits less electromagnetic waves than Class A equipment.)
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6-2 Power Saving Function

This product provides a power saving function that automatically turns the screen off when the product is not used for a 
predetermined period of time to reduce power consumption. If the product enters power saving mode, the power LED turns to a 
different color to indicate that the product is in power saving mode. 

When the product is in power saving mode, the power is not turned off and you can turn the screen on again by pressing any key 
or clicking the mouse. However, the power saving function only works when the product is connected to a computer that provides 
the power saving function.

 

If there is no power cut-off switch, the power consumption is "0" only when the power cord is disconnected.
 

POWER SAVING 
FUNCTION NORMAL OPERATION POWER SAVING MODE POWER OFF (POWER 

BUTTON)

Power LED On Blinks Off

Power Con-
sumption

P2370HD 51 watts

less than 2 watts less than 1 wattsP2570HD 59 watts

P2770HD 58 watts
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6-3 Contact SAMSUNG WORLDWIDE

 

• If you have any questions or comments relating to Samsung products, please contact the SAMSUNG customer care 
center.

 

NORTH AMERICA

U.S.A 1-800-SAMSUNG(726-7864) http://www.samsung.com/us

CANADA 1-800-SAMSUNG(726-7864) http://www.samsung.com/ca

MEXICO 01-800-SAMSUNG(726-7864) http://www.samsung.com/mx

LATIN AMERICA

ARGENTINA 0800-333-3733 http://www.samsung.com/ar

BRAZIL 0800-124-421

4004-0000

http://www.samsung.com/br

CHILE 800-SAMSUNG(726-7864) http://www.samsung.com/cl

COLOMBIA 01-8000112112 http://www.samsung.com/co

COSTA RICA 0-800-507-7267 http://www.samsung.com/latin

ECUADOR 1-800-10-7267 http://www.samsung.com/latin

EL SALVADOR 800-6225 http://www.samsung.com/latin

GUATEMALA 1-800-299-0013 http://www.samsung.com/latin

HONDURAS 800-7919267 http://www.samsung.com/latin

JAMAICA 1-800-234-7267 http://www.samsung.com/latin

NICARAGUA 00-1800-5077267 http://www.samsung.com/latin

PANAMA 800-7267 http://www.samsung.com/latin

PUERTO RICO 1-800-682-3180 http://www.samsung.com/latin

REP. DOMINICA 1-800-751-2676 http://www.samsung.com/latin

TRINIDAD & TOBAGO 1-800-SAMSUNG(726-7864) http://www.samsung.com/latin

VENEZUELA 0-800-100-5303 http://www.samsung.com/latin

EUROPE

AUSTRIA 0810 - SAMSUNG(7267864,€ 0.07/min) http://www.samsung.com/at

BELGIUM 02 201 2418 http://www.samsung.com/be (Dutch)

http://www.samsung.com/be_fr 
(French)

CZECH REPUBLIC 800 - SAMSUNG (800-726786) http://www.samsung.com/cz

DENMARK 8 - SAMSUNG (7267864) http://www.samsung.com/dk

EIRE 0818 717 100 http://www.samsung.com/ie

FINLAND 30 - 6227 515 http://www.samsung.com/fi

FRANCE 01 4863 0000 http://www.samsung.com/fr
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GERMANY 01805 - SAMSUNG (7267864,€ 0.14/
Min)

http://www.samsung.de

HUNGARY 06-80-SAMSUNG(726-7864) http://www.samsung.com/hu

ITALIA 800-SAMSUNG(726-7864) http://www.samsung.com/it

LUXEMBURG 02 261 03 710 http://www.samsung.com/lu

NETHERLANDS 0900 - SAMSUNG (0900-7267864) (€ 
0,10/Min)

http://www.samsung.com/nl

NORWAY 3 - SAMSUNG (7267864) http://www.samsung.com/no

POLAND 0 801 1SAMSUNG (172678)

022 - 607 - 93 - 33

http://www.samsung.com/pl

PORTUGAL 808 20 - SAMSUNG (7267864) http://www.samsung.com/pt

SLOVAKIA 0800-SAMSUNG(726-7864) http://www.samsung.com/sk

SPAIN 902 - 1 - SAMSUNG (902 172 678) http://www.samsung.com/es

SWEDEN 0771 726 7864 (SAMSUNG) http://www.samsung.com/se

SWITZERLAND 0848-SAMSUNG(7267864, CHF 0.08/
min)

http://www.samsung.com/ch

U.K 0845 SAMSUNG (7267864) http://www.samsung.com/uk

CIS

BELARUS 810-800-500-55-500

ESTONIA 800-7267 http://www.samsung.com/ee

LATVIA 8000-7267 http://www.samsung.com/lv

LITHUANIA 8-800-77777 http://www.samsung.com/lt

MOLDOVA 00-800-500-55-500

KAZAKHSTAN 8-10-800-500-55-500 http://www.samsung.com/kz_ru

KYRGYZSTAN 00-800-500-55-500

RUSSIA 8-800-555-55-55 http://www.samsung.ru

TADJIKISTAN 8-10-800-500-55-500

UKRAINE 8-800-502-0000 http:// www.samsung.com/ua 

http://www.samsung.com/ua_ru

UZBEKISTAN 8-10-800-500-55-500 http://www.samsung.com/kz_ru

ASIA PACIFIC

AUSTRALIA 1300 362 603 http://www.samsung.com/au

CHINA 400-810-5858

010-6475 1880

http://www.samsung.com/cn

HONG KONG 3698 - 4698 http://www.samsung.com/hk

http://www.samsung.com/hk_en/

INDIA 3030 8282

1-800-3000-8282

1800 110011

http://www.samsung.com/in

EUROPE
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INDONESIA 0800-112-8888 http://www.samsung.com/id

JAPAN 0120-327-527 http://www.samsung.com/jp

MALAYSIA 1800-88-9999 http://www.samsung.com/my

NEW ZEALAND 0800 SAMSUNG (0800 726 786) http://www.samsung.com/nz

PHILIPPINES 1-800-10-SAMSUNG(726-7864)

1-800-3-SAMSUNG(726-7864)

1-800-8-SAMSUNG(726-7864)

02-5805777

http://www.samsung.com/ph

SINGAPORE 1800-SAMSUNG(726-7864) http://www.samsung.com/sg

THAILAND 1800-29-3232, 02-689-3232 http://www.samsung.com/th

TAIWAN 0800-329-999 http://www.samsung.com/tw

VIETNAM 1 800 588 889 http://www.samsung.com/vn

MIDDLE EAST & AFRICA

SOUTH AFRICA 0860-SAMSUNG(726-7864) http://www.samsung.com/za

TURKEY 444 77 11 http://www.samsung.com/tr

U.A.E 800-SAMSUNG(726-7864)

8000-4726

http://www.samsung.com/ae

ASIA PACIFIC
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